


EndNote, Mendeley, Zotero, JabRef

 4 logiciels similaires très utilisés à INRAE, dans la communauté 

scientifique et le milieu universitaire

 Multiplateformes : Mac, Windows, IPhone, IPad, Android

 Compatibles avec les principaux navigateurs

 Installation sur le poste de travail

 Possibilités de partage de références et/ou de fichiers PDF

 Formatages des citations et de la bibliographie de textes saisis sous un 

traitement de texte



Les critères de choix présentés ici

 Relèvent de comparaisons entre les quatre outils dans le contexte 

d’utilisation des ressources bibliographiques électroniques disponibles à 

INRAE

• Revues scientifiques

• Bases de données bibliographiques (Web of Science, Pubmed, Scopus…)



Quel traitement de textes utilisez-vous ?

 Quel traitement de textes utilisez-vous ?

• Word, Open Office ou Libre Office             vous pouvez utiliser EndNote, Mendeley, 
Zotero et JabRef

• LaTeX utilisez de préférence le logiciel JabRef 

 En fait, LaTeX étant un formateur de documents, il a juste besoin d’une 
base .bib. 

 Par contre, les IDE type TeXStudio, TexMaker, Emacs, ont des outils du 
type « Cite-as-you-write ».



Quel traitement de texte utilisez-vous ?

• Word, Open Office ou Libre Office                       vous pouvez utiliser EndNote, Mendeley, 
Zotero et JabRef

Attention : EndNote n’est pas compatible avec Libre Office Writer 64 bits

• LaTeX préférez le logiciel JabRef 

LaTeX étant un formateur de documents, il a juste besoin d’une base .bib. 

Il est possible d’utiliser Zotero pour générer et gérer cette base .bib (plug-in BetterBibTeX
à installer)

A noter que les IDE1 type TeXStudio, TexMaker, Emacs, Overleaf, permettent d’écrire des 
documents LaTeX en format PDF et proposent des outils du type « Cite-as-you-write ».



Travaillez-vous sous Linux ?

❌

✔

✔

✔



Quel logiciel utilisent vos collègues ?

 Il est préférable de choisir le même logiciel que vos collègues pour :

• Échanger rapidement des références

• Obtenir de l’aide en cas de besoin



Quel coût ? Quel type de licence ?

 Pour utiliser EndNote, vous aurez besoin d’une licence payante (environ 200 €). 
EndNote fait partie des outils distribués par Clarivate Analytics (qui fournit aussi la 
base de données bibliographiques Web of Science)

 Mendeley , Zotero  et JabRef sont gratuits 

• Mendeley est la propriété de l’éditeur Elsevier (site Science Direct),

• Zotero est un outil libre (open source), sponsorisé par George Mason University.

• JabRef est un logiciel open-source gratuit

 Le partage de références/PDF sur Internet avec EndNote, Mendeley et Zotero
peut engendrer des coûts 

 L’utilisation de JabRef n’entraîne aucun coût et il est possible d’utiliser un 
espace collectif comme SharePoint /Next Cloud ou individuel comme 
OneDrive. 

 Il est aisé d’exporter des fichiers vers les trois logiciels cités précédemment. 

 C’est plus sécuritaire et vous n’avez pas de limite de stockage.



Fiabilité de l’outil ? Evolution? Avenir ?



Etes-vous « mobile » (1) ?

 Visualiser ses références sur Ipad, iPhone, tablette ou téléphone 

Android

❌ ✔ ✔ ✔

❌ ✔ ✔ ❌

✔ ✔ ✔ ❌

✔
❌

✔
❌

•

•



Etes-vous « mobile » (2) ?

 Disposer de ses références via Internet quel que soit le poste de travail

• Nécessite de disposer d’une copie de sa bibliothèque sur un serveur distant

• Peut engendrer des coûts car l’espace de stockage gratuit est limité



Voulez-vous partager des références 

bibliographiques via l’Internet avec vos collègues ?
 Possibilité ainsi d’interagir sur des références bibliographiques/pdf dans un 

espace commun : coûts et limites 

Lié 



Création automatique des références

À partir de fichiers pdf

 A partir de fichiers pdf stockés 

sur le poste de travail au fur et à 

mesure de la navigation sur 

l’Internet, le logiciel créée 

automatiquement une référence 

et lui attache le pdf

 Le pdf doit être bien formaté 

(exclu un pdf créé à partir de 

Word, par exemple)

A partir d’un site d’éditeur

 Les références peuvent être 

récupérées automatiquement

 Selon l’outil choisi et l’accès à la 

revue, le pdf sera 

automatiquement récupéré



Création de référence à partir du fichier 

PDF



Récupération automatique de références/pdf

d’articles sur les sites d’éditeur



Souhaitez-vous ne pas laisser de traces ?
 C’est-à-dire être invisible par rapport à Internet :



Interrogation à distance

 Il s’agit d’interroger des sources externes sans quitter le logiciel



Les critères de choix

 les procédures d’import des références (modalités, nombre et profil des sources compatibles, 
exactitude et fiabilité de l’import, etc.), 

 les fonctions de gestion de la bibliothèque de références et de ses documents associés (possibilités 
de classement, d'enrichissement des références, fonctions de recherche dans le corpus, gestion 
des PDF associés), 

 les options de publication en lien avec la citation dans le traitement de texte, 

 les possibilités en termes de partage, de collaboration et de réseau social ».

 Bien analyser ses besoins afin de s'assurer que les sources d’intérêt sont compatibles avec 
l’importation automatique des références dans le logiciel, 

 mais aussi que l’outil possède les styles d’écriture des citations et listes bibliographiques demandés 
par les revues de son domaine et de la disponibilité en ligne (cloud) de ses données

 être attentif aux possibilités de configuration du logiciel, en particulier pour créer ses propres grilles 
de description bibliographique et ses propres styles, est également recommandé ». 

 Un dernier conseil : choisir le logiciel utilisé dans sa communauté peut être un bon moyen de 
favoriser et simplifier les pratiques collaboratives



Changer de logiciel

 EndNote, Mendeley, Zotero et JabRef peuvent échanger des données grâce à 

des exports dans différents formats

 Il peut y avoir des pertes d’informations lors du passage d’un logiciel à un autre 

et selon le type de document, les informations de groupe/collection, les 

personnalisations et les liens vers les pdf ne sont pas toujours conservés, des 

vérifications poussées seront nécessaires.

EndNote Mendeley Zotero JabRef

✔ ✔✔ ✔

✔ ✔✔ ✔✔

✔✔ ✔✔ ✔✔

✔ ✔✔ ✔✔



Découvrir

les logiciels

EndNote, Mendeley, 

Zotero et JabRef



ENDNOTE



Caractéristiques techniques

 Logiciel payant : http://www.endnote.com/

 Multiplateforme : Windows,  Mac 

 Couplage avec Word, LibreOffice, apple

 Version Internet EndNote online : outil de partage de références et 

réseau social 

 Application Endnote sur ipad

 Limite de stockage : version locale illimitée, version online 50 000 

références, 2Go

http://www.endnote.com/


Fenêtre principale – Version X9



Fenêtre principale – Version 20



Les références bibliographiques 

Visualisation,  édition



MENDELEY



Qu’est ce que Mendeley ?









• Outil bibliographique 

o pour gérer, partager, lire, annoter et citer des références bibliographiques

• Réseau social

o Permettant le partage de travaux et de documents, la collaboration

entre scientifiques



Qu’est ce que Mendeley ?

 Outil multiplateforme

 Compatible avec les principaux navigateurs

 3 versions

Nouvelle version Mendeley Reference Manager pas encore équivalente 
au Desktop mais téléchargeable et en cours d’amélioration

https://www.mendeley.com/reference-management/reference-manager


L’interface Mendeley web

 L’interface a changé depuis déc. 2020, des fonctionnalités ont été 

arrêtées : Feed, Suggest, Groupes publics, Datasets, Careers et 

Funding

 Les différents onglets :

• Library : bibliothèque du titulaire du compte

• Groups : groupes d’intérêt mais seulement des groupes privés

• Search :

• Profil 



Interface web – My Library

•

•

•



ZOTERO



Caractéristiques techniques

 Logiciel libre et gratuit : http://www.zotero.org/

 Créé en 2006 et soutenu par George Mason University (USA)

 Multiplateforme : Windows, Linux et Mac 

 Navigateurs : Firefox, Safari, Chrome

 Couplage avec Word, LibreOffice

 Version Internet : outil de partage de références et réseau social 

http://www.zotero.org/


Les différentes versions de Zotero

 Zotero (auparavant appelée Zotero Standalone) : à installer sur son 

poste de travail

 La version plug-in de Firefox (version historique) n’existe plus en 

version 5

 Plateforme Web de partage de références

 Version mobile (Android, iPhone, iPad) : pas de version officielle 

(voir en fin de support)

La version courante est la version 5 (sortie en juillet 2017)



Fenêtre principale de Zotero

Les collections
Tableau des références

Détail d’une

référence

Recherche par  

marqueurs

(mots-clés)

PDF attaché à 

la référence



Détail d’une référence

4 onglets :

• Info = auteurs, titre, …

• Notes = notes de lecture

• Marqueurs = Mots-clés

• Connexe = établir un lien 

entre deux notices



JABREF



Caractéristiques techniques
• JabRef est un logiciel de gestion bibliographique libre qui utilise BibTeX et BibLaTeX comme formats natifs : 

https://www.jabref.org/ org/

• JabRef fournit une interface conviviale pour éditer des fichiers Bib(La)TeX, pour importer des références à partir de bases de 
données scientifiques en ligne et pour gérer et effectuer des recherches sur des fichiers Bib(La)TeX.

• Le programme fonctionne avec les systèmes d'exploitation Microsoft®, Windows®, Linux® et Mac OS X®. 

NB : les raccourcis ne sont disponibles que pour Windows et Linux (passer par les menus pour MacOs).

• Production des sorties entièrement compatibles avec BibTeX et BibLaTeX

• Insertion de citations et de références bibliographiques dans Microsoft Word à l'aide d'une macro word ou à partir du fichier 
.xml

• Insertion de citations et de références bibliographiques dans OpenOffice.org Writer et LibreOffice Writer.

• Facilité d'édition, de recherche et d'affichage des références

• Regroupement des références pour les organiser de manière explicite, basée sur des mots-clefs ou sur des termes de 
recherche généraux

• Génération configurable des clefs BibTeX

• Filtres d'importation pour 15 formats bibliographiques

• Recherche et téléchargement direct à partir de PubMed, SPIRES, ACM Digital Library et IEEEXplore. 

• Téléchargement direct depuis CiteSeer et ArXiv

• Filtres d'importation et d'exportation configurables

• Liens vers des ressources externes (URL, fichiers PDF ou PS, numéro DOI) qui peuvent être ouverts d'un unique clic

• Possibilité d'insertion automatique des citations dans des applications telles que LyX, Kile, Emacs et WinEdt.

• Lancement sans interface graphique pour la conversion des fichiers bibliographiques

https://www.jabref.org/
http://www.zotero.org/


Version JabRef « Bureau » ou « Portable »

 Vous pouvez opter pour 2 possibilités en 

fonction de votre système d’exploitation. 

Les liens suivants vous permettent de 

télécharger directement la version qui 

vous convient.

 Version « Bureau » :

• JabRef Windows Installer

• JabRef RPM

• JabRef Debian and Ubuntu

• JabRef Mac OS dmg

• JabRef Mac OS pkg

 Version « Portable » :

• JabRef Windows portable

• JabRef Linux portable

• JabRef Mac OS portable

 La version 5.5 est sortie officiellement le 17 

janvier 2022

 Cliquez sur le lien suivant : 
https://docs.jabref.org/installation

 Pour vérifier la version de JabRef, aller 

dans Aide -> A propos :

https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5.msi
https://www.fosshub.com/JabRef.html?dwl=jabref-5.5-1.x86_64.rpm
https://www.fosshub.com/JabRef.html?dwl=jabref_5.5-1_amd64.deb
https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5.dmg
https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5.pkg
https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5-portable_windows.zip
https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5-portable_linux.tar.gz
https://www.fosshub.com/JabRef.html?dwl=JabRef-5.5-portable_macos.tar.gz
https://docs.jabref.org/installation


Fenêtre principale de JabRef - Lancement

 Par défaut, au premier lancement de JabRef, il n’y a aucune base et la 

langue est en anglais mais il suffit de changer les préférences 

linguistiques (Cf Personnalisation de JabRef). 

Barre de menus
Barre  d’outils

Volet 
Recherche 

Web 
Groupes

Fenêtre 
principale



Personnalisation de JabRef

 Afficher les menus en français : 

• Options → Préférences pour JabRef → General → Langue : FRENCH, Encodage par défaut : UTF-8, Cliquez sur 

Save (Cf. slide Options)

 Changer la police : 

• Options → Préférences pour JabRef → Aspect → Police -> Taille à saisir ou Thème visuel : clair ou sombre, à 

choisir

 Activer l'autocomplétion des mots/noms qui ont été déjà saisis dans le champ respectif de la banque : 

• Options → Préférences → Éditeur d'entrées → Activer l’auto-complétion Nom Prénoms par exemple

 Autoriser les champs spéciaux (rang, pertinence, qualité et priorité) : 

• Options → Préférences → Table des entrées → Cocher Autoriser les champs spéciaux et Montrer les colonnes 

supplémentaires

 Pour en savoir plus  :

• JabRef peut être configuré de différentes manières → Cliquez sur le lien

• Informations avancées -→ Cliquez sur le lien

https://docs.jabref.org/setup
https://docs.jabref.org/advanced


Détail d’une référence

 JabRef reconnaît les mêmes types de références que BibTeX et tous les 

autres types communs

Vous connaissez le DOI 
de l’article, l’ISBN ou 
même le titre  (Cf liste 
déroulante)
-> il suffit de le 
renseigner et la 
référence est rajoutée 
automatiquement à la 
base

Détail de la référence 
sélectionnée selon le style 
– ici Article

Nous retrouvons 
ici les types 
usuels : Article, 
Book, 
InProceedings, 
TechReport, Misc
mais aussi 
d’autres types 
comme InBook, 
Unpublished, 
MastersThesis, 
PhdThesis, 
Patent, 
Standard…

Un simple copier/coller de DOI dans la 
table des entrées, cela fonctionne aussi



Enregistrer des 
références 

bibliographiques



Ajout de références
Zotero Mendeley Endnote JabRef

Plugin sur le navigateur 
pour intégrer 
automatiquement des 
références

Efficace Limité Insatisfaisant Efficace

Importation de fichiers 
RIS issus de différentes 
sources : bases de 
données, logiciels de 
gestion de biblio, …

Efficace Efficace Nombreux 
filtres de 
connexion

Efficace

Ajout de références par 
DOI

Valide Valide Valide Valide

Ajout de références par 
détection des 
métadonnées des PDF

Limité Efficace Seulement en 
présence d’un 
DOI

Valide

Enregistrement de 
pages web

Valide NON NON Valide

Ajout manuel Valide Valide Valide Valide



Espace de stockage disponible pour les 

fichiers joints

Espace de 
stockage

EndNote Mendeley Zotero JabRef

5 Go
pour la version
gratuite
illimité pour la
version
payante

2 Go
pour la version
gratuite

300 Mo
pour la version
gratuite
option 
d'utiliser
un serveur
Webdav
(gratuit)

L’espace de 
stockage des 
fichiers peut se 
faire sur un 
serveur ou 
espace 
collaboratif. 
JabRef 
n’impose 
aucune limite 
de taille.



Rechercher dans ses références

 Recherche simple et dans tous les champs possible pour tous les 

logiciels.

 Recherche avancée dans la base et les documents pour JabRef (depuis 

version 5.4).

 Pour Mendeley la recherche avancée ( par opérateurs booléens, par 

expression, …) n’est pas disponible.

 Ajout de notes à une référence possible pour tous les logiciels.

 Possibilité de créations de dossiers multiniveaux pour Zotero, Mendeley 

et JabRef.



Gérer et 
classer 

les références



Attacher des fichiers aux références

 Classement des références sous formes de dossiers, sous dossiers 

pour tous les logiciels.

 Possibilité de lier plusieurs fichiers de type différents à une référence 

pour tous les logiciels.

 Annotation des pdf et surlignage des pdf disponibles mais installation 

d’un plug-in supplémentaire pour Zotero.



Utiliser et citer 
les références 

dans un 
document



Rappel Citation dans un texte, article, rapport,…

On cite pour :

 respecter le droit d'auteur;

 rendre justice à l'auteur de qui on a tiré l'idée;

 donner de la crédibilité à son travail;

 démontrer une rigueur scientifique;

 permettre le repérage des sources.

On cite quand :

 on reprend mot à mot l'idée de quelqu'un d'autre;

 on reprend l'idée d'une autre personne dans nos propres mots 

(paraphrase);

 on fait référence à l'idée, l'opinion d'une autre personne;

 on utilise des données secondaires (statistiques, graphiques, etc.).

 Que l'information provienne de sources imprimées ou en ligne, d'un 

document publié ou non publié, les sources protégées par le droit 

d'auteur ou du domaine public, les mêmes règles s'appliquent.



Notion de style

 Un style est un fichier traduisant les instructions aux auteurs d’un 

journal ou d’un ensemble de journaux sur la mise en forme des 

citations dans le texte et de la bibliographie.

 Un style porte le nom du journal en entier ou en abrégé.

 Utilisé avec un traitement de texte (Word, LibreOffice ou Latex), il 

permettra une forme facile du texte et de générer automatiquement 

une liste bibliographique comprenant l’ensemble des références 

citées dans le texte. 



Qu’est ce qu’un style bibliographique?
Il existe plusieurs styles ou normes pour la rédaction des références 

bibliographiques : des styles internationaux, nationaux, ou propres à un champ 

disciplinaire ou à une culture professionnelle. 

 Ces styles diffèrent sur l’ordre d’écriture des éléments décrivant le document 

(auteur, année, titre, lieu d’édition … ou auteur, titre, lieu d’édition, éditeur, 

année …), sur la ponctuation requise ou sur la typographie recommandée 

(italique ou gras pour le titre, guillemets ou non …). 

 La référence bibliographique est comme la « carte d’identité » du document. 

Elle permet d’en connaître le titre, l’auteur, la date de publication etc. et est 

rédigée selon un style/une norme.

 La liste des références bibliographiques est la liste mise en forme et classée 

des références bibliographiques. Elle est située dans le rapport, l’article,… 

après la conclusion et avant les éventuelles annexes. Elle contient 

exclusivement les références des documents cités dans votre écrit.



Les styles de citation

Standards de la rédaction d’une bibliographie  s’inspirant la norme 

internationale  ISO 690 et reprise en France par les normes AFNOR Z44-

005 (références, contenu, forme et structure) et AFNOR Z 44-005-2 (informations et 

documentation : doc électroniques, …)

Le « style » détermine :

• L’impression de lots de références selon des normes définies

• Le formatage des citations et de la bibliographie dans les articles

• Le format d’export pour des lots de références

On peut classer les références soit :  

• par ordre alphabétique des noms d'auteur, ou du titre lorsque la 

publication est anonyme   

• par ordre d'apparition dans le texte, numéroté, avec renvoi depuis le 

texte vers la bibliographie 



Utilisation et modifications de styles

 Nombreux styles proposés par les 4 logiciels

 Modifications de style assez simple pour EndNote et moins conviviale 

pour les autres logiciels.

EndNote Mendeley Zotero JabRef

Nombre de 
styles 

disponibles

6926 9464 9464 Style 
Bib(La)tex

(15 formats)





Personnaliser son affichage

 Trier les listes de références

 Sélectionner les champs à afficher et leur ordre

 Réorganiser les sections de l’interface

 Renommer le libellé des champs (EndNote : 8 champs personnalisables, 

JabRef : personnalisation et modification de tous les champs, création de 

nouveaux types de références avec caractère optionnel ou requis) 

 Renommer des fichiers pdf

 Personnaliser les groupes par code couleur

 Changement de la langue d’affichage (JabRef : anglais vers français)





Collaborer par échange de fichiers

 Le format du fichier à créer dépend du logiciel vers lequel les données seront 
importées. Pour importer dans :

• Reference Manager ou EndNote : format EndNote XML+ transfert des 
PDFs via l’explorateur. 
Voir à : http ://ist.blogs.inra.fr/questionreponses/2016/06/20/transfert-de-
zotero-a-endnote/
Problèmes éventuels si les noms des fichiers pdf sont trop longs, les 
informations de collection ne sont pas transférées.

• Mendeley : format Bibtex u via la déclaration de la bibliothèque Zotero 
dans Mendeley : Tools > Options > Zotero

 Cet import ne fonctionne pas correctement avec la version 5 de 
Zotero au 21/08/2017

 Faire un export de la base Zotero en format Bibtex (Fichier > 
Exporter) puis, dans Mendeley, un import (File > Import)

• Zotero : format export Zotero RDF

• JabRef : BibTeX (*.bib), BibTeXML (*.bibx;*.xml), Biblioscape (*.txt), Copac
(*.txt), EndNote XML (*.xml), INSPEC (*.txt), ISI (*.isi;*.txt), MODS (*.xml), 
MSBib (*.xml), Medline/PubMed (*.nbib;*.xml), Medline/PubMed Plain 
(*.nbib;*.txt), Ovid (*.txt), PDF avec annotations XMP (*.pdf), PDF content 
(*.pdf), RESPEC New Economic Papers (NEP) (*.txt), RIS (*.ris), 
Refer/EnNote (*.ref;*.enw), SilverPlatter (*.dat;*.txt)

http://ist.blogs.inra.fr/questionreponses/2016/06/20/transfert-de-zotero-a-endnote/


Import d’un fichier EndNote dans Zotero

 Dans EndNote, après avoir activé le style Format Refman RIS 

Export (catégorie Export), exporter les références : File > Export :

 Dans Zotero, Fichier > Importer 

 Les références sont placées dans une collection portant le nom 

du fichier importé 

Si la bibliothèque EndNote contient 

des PDFs, créer le fichier d’export 

sous le répertoire .Data de la 

bibliothèque EndNote, voir à :: 
http://ist.blogs.inra.fr/questionreponses/20
15/03/13/transfert-de-references-et-de-pdf-

de-endnote-a-zotero/ à : 

http://ist.blogs.inra.fr/questionreponses/2015/03/13/transfert-de-references-et-de-pdf-de-endnote-a-zotero/


Import d’une bibliothèque Mendeley dans 

Zotero

 Export BibTeX, liens vers les PDFs conservés, perte des groupes

 Dans Mendeley : File > Export, choisir un format BibTeX

 Dans Zotero :  Fichier   > Importer

 Les références sont placées dans une collection portant le nom du 

fichier importé 

 La répartition en groupes de la bibliothèque Mendeley, certains 

fichiers attachés, des enrichissements dans les Notes (gras) ne sont 

pas conservés.



Echanger avec d’autres logiciels 

bibliographiques

 Vers d’autres logiciels :  File > Export 

• Format RIS vers Zotero, EndNote, JabRef

• Format Bib(La)Tex vers Jabref

• Format EndNote XML (vers EndNote X et sup.)

Permet de récupérer les fichiers associés aux références.



EndNote -A partir de document Word -

Travelling Library

 Liaison EndNote – Word : une « Traveling library » est associée au 

texte Word.

 Cette bibliothèque peut être extraite du fichier (soit à partir de Word, 

soit à partir de EndNote) et permet donc des échanges entre 

différents utilisateurs …

 Dans les outils EndNote de Word :

 Option 

« Export Traveling Library »



Echange et partage de fichiers avec des 

utilisateurs d’autres logiciels

 Echanges possibles avec Mendeley, EndNote, Zotero

 File > Export sélectionner le format

 Le format Export XML permet de transférer les pdf associés aux 

références

 Risque de perdre des informations car il y a plus de champs 

descriptifs dans EndNote quand dans les autres logiciels (exemple 

les 8 Custom)
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Collaborer par échange de fichiers - JabRef

 La bibliothèque est sauvegardée en tant que simple fichier texte et est donc facile à partager avec d'autres 

utilisateurs via n’importe quel outil collaboratif institutionnel INRAE : SharePoint/OneDrive/DropBox/NextCloud.

 Pour faciliter le partage d'une base de données Bib (La) TeX, il est recommandé de définir des propriétés de 

base de données spécifiques (Cliquez ici pour en savoir plus).

• Dans le menu Contenu  Propriétés du fichier 

• Encodage du fichier  UTF-8

• Mode de fichier  BibTex

• Choisir les emplacements de « Répertoire général », « Répertoire de fichiers spécifiques à l’utilisateurs » 

(Ex. pdf non liés par exemple), « Répertoire de fichiers LaTeX ».

• Protection du fichier  Cocher « Refus d’enregistrement du fichier tant que les changements externes ne 

sont pas vérifiés

• Exporter l’ordre de tri et choisir les critères, il est recommandé de choisir : Year Author Title

• Opérations lors de l’enregistrement   Cocher « Activer les formateurs de champs » (Ex. Title : casse de la 

phrase, permet de mettre Titre avec 1ère lettre en majuscules)

https://docs.jabref.org/collaborative-work/sharedbibfile


Collaborer avec d’autres utilisateurs de la 

communauté JabRef INRAE

 JabRef peut s’adapter à vos besoins et il vous suffira d’appartenir à la 

communauté JabRef INRAE dont l’espace Share Point a été 

spécialement conçu pour vous aider et améliorer l’outil : 

https://sites.inrae.fr/site/reseau-ist/communaute-jabref

• Il suffit de faire une demande pour accéder au site

https://sites.inrae.fr/site/reseau-ist/communaute-jabref


Niveau
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Zotero et versions mobiles

 Il n’y a pas d’application Zotero officielle pour Android, iPhone et 

iPad

 Plusieurs solutions possibles : https://www.zotero.org/support/mobile

 Barcode Scanner by IOS (Ipad, Iphone) permet d’ajouter des 

ouvrages en scannant leur code-barre

 Scanner for Zotero (Android) permet d’ajouter des documents dans 

sa bibliothèque Zotero en scannant leur code-barres ISBN

Niveau

2

https://www.zotero.org/support/mobile
https://www.zotero.org/blog/scan-books-into-zotero-from-your-iphone-or-ipad/


• Lien – version iOS

voir : 

https://www.mendeley.com/guides

/ios

Mendeley -Accès mobile -

iOS & Android

 Lien d’accès sur Google Play

https://www.mendeley.com/guides/ios
https://play.google.com/store/apps/details?id=com.mendeley&&referrer=utm_content=9cf46992-d424-4030-937f-40f3211525bd&utm_medium=ad-analytics&utm_source=flurry&utm_campaign=Android%20Launch%20(Blog)


Accès mobile à EndNote

 A partir d’EndNote web > EndNote mobile

 Application gratuite pour iPad®



JabRef – Pas de version mobile

 Il faut connaître cette fonctionnalité, une base peut être hébergée sur un 

serveur PostgreSQL pour d’avantage de sécurité, accessible aux 

utilisateurs à condition d’avoir un LDAP INRAE et accès VPN par 

mesure de sécurité (pas besoin d’utiliser SSL). Pour en savoir plus, 

cliquer ici

https://docs.jabref.org/collaborative-work/sqldatabase


Conclusion
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Bilan
EndNote Mendeley Zotero JabRef

Avantages Personnalisable
Recherche 
automatique de 
pdf simple
Module de 
rédaction souple
Liens entre 
citations et 
bibliographie 
(hyperliens)

Intuitif
Utilisation de 
Notebook

Intuitif d’utilisation
Import facile de 
différents documents, 
site web, fichier pdf

Gratuit
Récupération facile de 
documents en texte 
intégral
Interface conviviale et 
personnalisable
Recherche simple et 
avancée dans un ou 
plusieurs documents
Pas de limite de stockage 
de document

Inconvénients Payant 
Pas toujours très 
intuitif dans son 
utilisation

Pas d’import 
automatique des 
pdf (insertion 
depuis disque dur)
Modification des 
styles difficile
Pas de hyperliens 
entre citations et 
bibliographie

Classement de la 
bibliothèque pas 
toujours lisible 
Modification des 
styles difficile
Pas de hyperliens 
entre citations et 
bibliographie (sauf 
dans LateX)

Insertion bibliographique 
dans Microsoft Word dans 
des formats limités.
Logiciel offrant de 
multiples fonctionnalités, 
prise en main complexe.



Liens utiles
EndNote Mendeley Zotero JabRef

Supports :
• http://clarivate.libguides.com/e

ndnote_training
• http://clarivate.libguides.com/l

d.php?content_id=42326715
• https://guides.biblio.polymtl.ca

/endnote
• Style bibliographique HEC 

Montréal - bordereaux EndNote 
- EndNote 20 - Guides at HEC 
Montréal

Videos :
• http://clarivate.libguides.com/e

ndnote_training/users/enx9
• https://clarivate.libguides.com/

endnote_training/users/en20

Supports :
• Guides | Mendeley
• Microsoft Word - guide 

-MendeleyV5.doc (univ-
montp2.fr)

• Faire sa bibliographie 
avec Mendeley 
(unistra.fr)

Vidéo :
• https://www.youtube.c

om/watch?v=Gv6_HuCY
ExM

Supports :
• http://zotero.hypotheses.

org/
• Support pour des 

manipulations avancées 
(modification de styles, 
sauvegardes, utilisation 
d’extension) 

• Tutoriel pour la 
modification des styles

• De nombreux outils 
peuvent être ajoutés à 
Zotero pour les 
imports/exports, pour une 
amélioration de 
l’interface, pour une 
analyse de la bibliothèque, 
pour l’intégration des 
données dans un site Web 
(avec WordPress, Drupal 
ou Spip…) et pour 
l’intégration dans les 
traitements de texte 

Vidéo :
• https://www.zotero.org/su

pport/screencast_tutorials

Supports :
• https://www.jabref.org/ : site 

officiel
• https://docs.jabref.org : aide 

en anglais
• https://www.fosshub.com/Jab

Ref.html : lien de 
téléchargement !

• Insertion de citations et 
construction automatique 
d’une liste de références dans 
Word® : article de Fabrice 
Dessaint paru dans les Cahiers 
Techniques INRA en 2013, 
toujours d’actualité.

Vidéos :
• Introduction to JabRef
• JabRef pour débutants (1) : 

Interface JabRef et création 
d’une base bibliographique

• JabRef pour débutants (2) : 
Comment gérer et citer ses 
références dans MS Word et 
Latex

http://clarivate.libguides.com/endnote_training
http://clarivate.libguides.com/ld.php?content_id=42326715
https://guides.biblio.polymtl.ca/endnote
https://libguides.hec.ca/endnote/bordereaux-HEC-Montreal
http://clarivate.libguides.com/endnote_training/users/enx9
https://clarivate.libguides.com/endnote_training/users/en20
https://www.mendeley.com/guides/
http://biblio.math.univ-montp2.fr/nvbibli/images/PDF/Mendeley-manuel%20dutilisation.pdf
http://urfist.unistra.fr/uploads/media/Faire_sa_bibliographie_avec_Mendeley.pdf
https://www.youtube.com/watch?v=Gv6_HuCYExM
http://zotero.hypotheses.org/
https://www.sites.univ-rennes2.fr/urfist/ressources/approfondissement-de-zotero
http://www.thomaslienhard.fr/TutorielZotero.html
https://www.zotero.org/support/plugins
https://www.zotero.org/support/screencast_tutorials
https://www.jabref.org/
https://docs.jabref.org/
https://www.fosshub.com/JabRef.html
https://www6.inrae.fr/cahier_des_techniques/Les-Cahiers-parus/Les-N-reguliers/2013/Cahier-N-79/Art5-ct79-2013
https://youtu.be/11qMBE_PSBw
https://youtu.be/oF22xJ9lDVk
https://www.youtube.com/watch?v=Q62nO-KDDZw


Autres sources de comparatifs

 Source Wikipedia (autres logiciels) : 

Comparison of reference management software – Wikipedia

 Université du Québec propose 3 outils pour vous aider à identifier 

lequel, parmi EndNote, Zotero et Mendeley, répond le mieux à vos 

besoins : répondez au quiz ou consultez le tableau comparatif (plus 

détaillé) qui sont disponibles sur le site Carrefour gestion 

bibliographique.

https://en.wikipedia.org/wiki/Comparison_of_reference_management_software
https://www.poll-maker.com/QBEU918
https://carrefour.uquebec.ca/comparaison-fonctions-logiciels-endnote-mendeley-zotero
http://carrefour.uquebec.ca/


Catalogue des Open Class Service Question / Réponse en IST 

ist.inrae.fr/produits-services/

Vous avez des questions sur le processus 
de publication (soumission, réponse à 

l’appel d’un  éditeur…), sur la recherche 
d’information ou de sa gestion, sur la 

veille pour votre sujet…? 
Q/R en IST vous répond en 3 jours

ist.blogs.inrae.fr/questionreponses

S’informer en Open Science

https://ist.inrae.fr/produits-services/
https://ist.blogs.inrae.fr/questionreponses/toutesqr/
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